Bharathidasan University

Centre for Differently Abled Persons
Tiruchirappalli-620024
Tamilnadu, india

P
P :%,;J\.
e » LS
L5 N
Vs 2
F5 %‘3‘1\
TR & %)
g 7 O% e
S VoA =)
N | ”~ A
; - 2

Bachelor of Computer Applications
(For Students with Hearing & Speech Impairment)

Course: Fundamentals of Computer Applications
Unit-5

Composed By
Dr. P. Kannan

Dr. M. Prabavathy
| @ @ \ (Assistant Professor)




Microsoft Powerpoint -
Objectives

After completing this lesson, you will be able to:

|dentify the basic functionalities offered by
presentation programs.

Create a presentation.
Add graphics and multimedia to a presentation.

Identify the various options available to print
presentations in different formats.



Introduction to PowerPoint

= Presentation programs, such as
PowerPoint, helps you create a presentation
and use audio-visual materials, such as
graphics and multimedia elements, to
present information.

= You can also distribute printed copies
containing the key points of your
presentation.
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To open PowerPoint:

= Click Start, point to All Programs, click Microsoft Office and
Click Microsoft Office PowerPoint 2007 or,
= Double click the PowerPoint icon on the desktop.
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presentation.

Presentation Programs
Microsoft Office PowerPoint

Objectives
After completing this lesson, you
will be abie to;

- Normal view is
divided into three
main working
areas.

= On the left you
have two tabs,
Slides and
Outline.

* Identify the basic functionalties
offerad by prasentation
programs.

¢ Create 3 presentation

* Add graphics and multimeda to a
presentation.

o Idenbfy the vancus opbons
lable to print pr n

diffsrent formats,

j « Introduction to PowerPoint

Open PowerPoint

* Use normal view to reate the
presentaton.

* Normal view Is divided Into thres
i workong areas

i Suppose you need to present the annual performance report of your company. You need B
* On the Ieft, you have twa tabs, J to show &l the facts and figures related to the profits, sales, products, and new ventures
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Presentation Programs
Microsoft Office PowerPoint

need to present the annual performance report of your company. You need to show all the
related to the profits, sales, products, and new ventures of your company. In the annual

- IEE

To view the slides
as thumbnails, In
the leftmost pane,
click the Slides
tab.

On the right, the
slide pane
displays a large
view of the
current slide.



Outline View

Microsoft Office PowerPoint
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After completing this lesson, you
wil be abie to;

* Idanbfy the basic functionalties
offerad by prasentation
programs.

* Create 3 presentation

* Add graphics and multimedia to a
presentation.

* Idenbfy the vancus options
lable to print pr n
diffecent formats,
Introduction to PowerPoint

Open PowerPoint
* Use normal view to reate the
presentation.

* Normal view Is divided Into thres
M3 workung areas.

* On the left, you have two tabs,

| Suppose you need to present the annual performance report of your company. You need 5
to show al the facts and figures related to the profits, sales, products, and new ventures
f vour comnany. [n_the anoual_results. wou alsn want to show, chacts that comnare.
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Outline view Is an
outline of all the
text that will
appear on your
slides.

Outline view is
used to edit the
text only.
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Suppose you need to present the annual performance report of your company. You need to show all the
facts and figures related to the profits, sales, products, and new ventures of your company. In the annual
results, you also want to show charts that compare asrent profit and sales figures with the figures of the
previous two years, In addition, you want to present the employee growth initiatives of the company and
also show videos of what employees have to say about these initiatives. You want to present all this
information to a large group of people effidently and effectively.

An effedlve and easy way to present this mfonnauon is lo use a uresenlatlon proqan such s

1 "
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To add notes to a
slide, click the
notes pane in
normal view.

Notes can contain
additional text that
you want to refer to
during your
presentation.



Slide Sorter View
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Notes Page View
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View the Notes Page to edit the
speaker notes as they'll look when

you print them out,
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Microsoft Office PowerPoint
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| Suppose you nead to present the snnus! report of your pany.
You need to show allthe facts snd figures related to the profis, ssies,
and new of yourcompany. In the annusiresults, you siso
wantto showcharts that compsre cumrent profit and sales figures with the
figures of the previous two years. In addition, you wantto presentthe
ployee growth initi ofthe pany and also show videos of what
employees have to say about these initistives. You want to present alithis
information to s iarge group of people efficiently and effectively.
An effective and essy way to present this i ionis to use a g '
program, suoh s PowerPoint. Presentstion program helps you creste visusl
quickly and i porste s vanety of medis, such astext,
graphics, charts snd v;deo into a single presentabon You can mske printed
copies of d your and di ittothe I
sudience.
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The notes page
view displays a
slide along with the
notes area.

Use this view to
enter text, pictures,
and tables in the
notes area.



Slide Show View
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Presentation Programs
Microsoft Office PowerPoint

MOUSTOM

= This view displays
the slides
sequentially in full
screen.

= The content in the
notes pane are not
displayed during a
slide show.
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Slide Show View (Cont.)

Presentation Programs
Microsoft Office PowerPoint

Click the mouse/press a key to
view the next slide during a
slide show.

You can also set PowerPoint
to automatically advance the
slides after a certain amount
of time passes.

To return to the normal view
any time during a slide show,
press the ESC key.



PowerPoint Handouts
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PowerPoint
Includes a feature
to print the slides
as handouts.

You can distribute
the handouts to
give the audience
an idea about the
presentation.

You can specify
the number of
slides on each
page and the
layout by clicking
Handout Master on
the View menu.



Creating a Presentation
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To select the Slide Layout, select “Layout” tab under “Home”
ribbon.



Creating a Presentation
Slide De5|gn
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To add a specific theme to the slide, click the “Design” tab, and
select the theme.



Creating a Presentation
New Slide
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| Add a slide to the presentation.
@) Press F1 for more help.
|

Click to add notes
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To add a new slide, click New Slide in the Slides Group on the

Home Ribbon.



Creating a Presentation
Add Text
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To add text, click Text Box from the Text Group on the Insert
Ribbon.



Creating a Presentation
Bulleted
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To add the bullets to a list, highlight the list and then click the
Bullets icon from the Paragraph Group on the Home Ribbon.



Creating a Presentation
Slide Transition
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To apply a transition effect to the presentation, go to the Animations
Tab.



Creating a Presentation

Save the Presentation

MS Office

L

a) MS Word
=b) MS Excel

¢) MS PowerPoint
.
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To save the presentation, click the Save button on the
Quick Access Toolbar.



Creating a Presentation

Add Graphlcs
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To add graphics to a slide, use the Insert Tab and select the
proper item.



Creating a Presentation
Add Graphics (cont.)
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Creating a Presentation
Add Graphics (cont.)
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Similarly, you can add graphlcs from flles by using the Insert Tab.




Creating a Presentation
Add SmartArt
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You can add a diagram to a slide by clicking SmartArt on the
Insert Tab.



Creating a Presentation
Add a Audio Clip
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You can use the sound effects in PowerPoint to produce sound effects such as
applause, a cash register, and a drum roll, in a presentation.



Creating a Presentation
Add a Audio File
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Similarly, you can add audio from files by clicking the Sound from File option.
For example, you can add the narration script that you recorded to the slide.



Printing Presentations

= You can print the entire presentation or
only a few selected slides, handouts, and
speaker notes from your presentation.

= You can also create an outline that lists
the contents of the slides and the images

used In the presentation.



Printing Presentations
Print an entire Presentation
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Recent Documents
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1 PowerPoint 2007
= 2 PowerPoint 2007
/=T Open
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H Save
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Printer

Name: ';g Microsoft Office Document Image Writer
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Type: Microsoft Office Document Image Writer Driver
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Comment: [ |Print to file
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V(Eo[‘/grrraryscale: | Order; @) Horizontal Vertical GEE
Grayscale [Z]
[5cale to fit paper Print hidden slides
[ |Frame slides [ High quality
[ | Print comments and ink markup
) o)

All: To print an entire presentation, in the Print range area, click All.
Next, in the Print what Box, click Slides, and then click OK.



Printing Presentations
Print Specific Slide
n 2]
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Printer
Name: @5 Microsoft Office Document Image Writer B
DL L - Find Printer...
Type: Microsoft Office Document Image Writer Driver
Where: Microsoft Document Imaging Writer Port:
Comment: [ Print to file
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@ slides: | Q
Enter slide numbers and/or slide ranges. For example,
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(V] Collate
Print what: Handouts
‘Slides E’ Slides per page; 5 : EIE
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["]scale to fit paper Print hidden slides
[ ] Frame slides [ High quality

| _|Print comments and ink markup
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Specific Slides: To print only specific slides, in the Print range area, click
Slides. Next, enter the slide numbers if you want to print slides individually or
enter the slide range if you want to print a range of slides, and then click OK. .



Print

Printer

Status: Idle

Printing Presentations
Print Handouts and Notes Pages

Name: @5 Microsoft Office Document Image Writer E

Type: Microsoft Office Document Image Writer Driver
Where: Microsoft Document Imaging Writer Port:

Comment: || Print to file
Print range Copies
@ All (") Current slide Selection Numb_er of copies:

Custom Show:

.' ‘: 1 ;‘
Enter slide numbers and/or slide ranges. For example, ﬂl Iﬁ

() Slides:
1,3,5-12
(V] Collate
Print what: Handouts
‘Slides E\ Slides per page: 6~ CaCel
Handouts der, (@) Horizontal Vertical CE10s
Notes Pages
Outline View [ | scale to fit paper Print hidden slides
|| Frame slides [ | High guality

Preview

| _|Print comments and ink markup

ok ][ concel |

Handouts: To print
handouts, click the Print
what box, click Handouts,
and then click OK.

*Notes Pages: To print the
notes from your
presentation, click the
Print what box, click
Notes Pages, and then
click OK.



Close a PowerPoint Presentatlon

87 PowerPoint 2007 [Compatibili Microsoft PowerPoint =HECIE X 5
——_— ut A—Nﬂ-ﬁnnn-Li P Ity_‘..h_‘ il —— o -
i | Home l Insert Design Animations Slide Show Review View Developer

=) Layout ~ l ol llu ER N~ B shape Fill - @4 Find
) x ) [EEEEE g
Reset 7 Shape Outli 21, Replace ~
Paste B5jRes iB e AHHA H%%%':'gg A—L—L'C:)GG_Anange e pe Outline ~ "‘ep ce
;f 5"“ 4 Delete =i o = = RO Frs ~ Styles~ = Shape Effects = || 3 Select~
‘_C[igggaid_".‘ Slides: Font Paragraph ) Drawing 5| Edting

& ,
Presentation Programs I\Qg

HOUSTON

Microsoft Office PowerPoint LERARS

e e v -

*on m s we

"'_“_. SUNNOSe Voul need 10 nresen ne annlia errormance renn 0 0 Qmnan QU _neea 1o SNOoOw 4 ne 1acts and naure
o = '8 ——
Slide 1 of 55 | “Default Design” | @ English (United States) | B8 FT|; (=)l

Close a presentation by clicking the Close Window button.
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existing presentation

To open an existing
presentation:

= On the Office
Button click open.

= |In the Open
dialog box, click the
file that you want to
open, and then
click Open.
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